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Programming the M8 USB Microcontrollers
with a Hi-Lo Programmer

 

Introduction
The purpose of this application note is to show developers
how to program the M8 USB microcontrollers using the Hi-Lo
programmer. Several vendors have programmers that sup-
port the M8 USB microcontrollers. Developers using a differ-
ent programmer should contact the programming
manufacturers for support. This application note only focuses
on the inexpensive CY3649, Hi-Lo System - Cypress USB
Programmer For Starter. Cypress parts can be purchased
from the Cypress local sales office or from the Cypress
Online Store at:

http://www.cypress.com/support/how_to_buy.cfm

Materials Needed
The new CY3649 looks similar to the old programmer that
was included with the discontinued development kit, the
CY3640. The difference is that the CY3649 has been
designed to support all the M8 USB microcontrollers and is
labeled Cypress USB Programmer For Starter while the old
programmer only supports the CY7C63000 and is labeled
Programmer for CY7C63000. 

The following tools are needed:

■ The programmer, Hi-Lo System - Cypress USB Program-
mer For Starter (Cypress Part ID: CY3649)

■ A center negative, 9VDC, 1000mA output wall bug (pro-
vided with the CY3649)

■ A RS232 cable with female connector type at one end and 
male connector type at the other (provided with the 
CY3649)

■ The Cypress Start Kit USB Programmer software (Cys-
tart.exe). This is freeware and can be downloaded from 
the Cypress web site: http://www.cypress.com/

■ An Adapter Base (needs to be purchased separately. See 
Appendix A for the required Adapter Base)

■ A Matrix Card (needs to be purchased separately. See 
Appendix A for the required Matrix Card)

Operational Overview
Cystart (GUI) is the software that runs on the PC. Cystart
allows the user to interface with the programmer such as
choosing the file to be programmed, setting target chip being
used, choosing the COM port for the serial cable and its baud
rate, reading the existing program on the chip's PROM,
checking whether the chip's PROM is blank, etc…

The programmer's hardware is where the programming pro-
cess takes place. Communication between the programmer
and Cystart.exe on the PC is through the RS232 cable.

The Adapter Base adapts the programmer for a specific
package type. Three types of adapters are available: SSOP,
SOIC, and PDIP. Depending on the package type of the chip,
a corresponding adapter is needed. Refer to Appendix A for
the required Adapter Base.

The Matrix Card routes the signal from the programmer to the
correct pin outs on the chip. Different parts have different pin
out listings. Refer to Appendix A for the required Matrix Card.

Figure 1 below shows the adapter inserted into the program-
mer's socket, and the matrix card inserted into the adapter.
Figure 2 shows the Cystart.exe GUI running on the PC.

AN075

 

[+] Feedback 

http://ccc01.opinionlab.com/o.asp?id=Text1&prev=docurate_001-17024_pdf_p_1


November 3, 2003 Document No. 001-17024 Rev. ** 2

AN075

Figure 1.  Hi-Lo Programmer’s Hardware

Step-By-Step Procedures
1. Power the programmer with the provided wall bug.

2. Connect the RS232 cable from the programmer to the PC.

3. Insert the Matrix Card into the Adapter Base with the print-
ed side facing up. Note that the Matrix Card is two sided, 
eachside supports a different part. The labels printed on 
the card show what side belongs to what part.

4. Put the Adapter Base into the zero-insertion-force (ZIP) 
socket on the programmer and push the lever on the pro-
grammer down to lock the Adapter Base in its position.  
Pin1 of the Adapter Base should be at the top left position 
on the socket as shown in Figure 1

5. Place a chip to be programmed into the Adapter Base's 
ZIP socket and push the Adapter Base's lever forward to 
secure the chip in its position. Note that the chip should 
be top justified, i.e. pin 1 of the chip should be placed at 
the top left position on the Adapter Base's socket.

6. Open the Cystart.exe software on the PC. See Figure 2.

7. From Cystart, click on the Setup menu. The I/O Base Ad-
dress window will pop up allowing the user to select the 
COM Port and the desired baudrate. The "Programmer 
Status" message at the end of this window shows status 
of the serial communication between the Cystart and the 
programmer hardware. When the "Programmer Status" 

message changes to "EXIST", click the "Cancel" button to 
close this window.

At this point, communication between the programmer and
the Cystart GUI has been established.  From the Cystart GUI,
the continuing steps allow the user to select the part and the
.hex file to be programmed on the part. The .hex  file is gener-
ated by the Cyasm assembler. To learn how to create the
.hex file, refer to the Cyasm User's Guide which can be
downloaded from Cypress web site at:
http://www.cypress.com/

8. Click on the Device menu and select the device to be 
programmed

9. From the File menu, select Load File to Buffer. The Load 
File menu will open to allow the user to browse to the .hex 
file that need to be programmed on the chip. Click on the 
.hex file and then OK. Note that the Cystart software is 16-
bit, so files and folders with long names will be truncated.

10. A File Format window will open.  Select the File Format = 
"Intel HEX", Unused Bytes = "Don't Care" or "FF", then 
click OK. The File Format window will automatically close.

11. Click the Program button to start programming.

Note that after the programming is done, the user needs to
click on the "Cancel" button to close the Program window.

Other features of the programmer are:

The Blank Check enables the user to verify that the chip
PROM cells contain all 1’s.

With the chip inserted in the Adapter Base's socket, clicking
the Read button, then the Edit menu allows the user to read
the contents of the PROM in the chip. The Edit menu also
enables the user to search or move bytes in the buffer, fill the
buffer with certain values, or edit the buffer. Note that the
PROM cells are defaulted to all 1s. Even though the M8 chips
are One Time Programmable (OTP), reprogramming the
chips with the cells being changed from "1" to "0" is permissi-
ble (assuming the security fuse has not been blown), but the
reverse is not possible. 

The Verify button ensures that the chip's PROM matches the
contents of the buffer.

After the chip has been programmed, clicking the Secu-
rity/Run buttons blows the chip's security fuse to prevent the
program on the chip to be read. Reading the chip after the
security fuse has been blown returns 0xFFs. 
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Figure 2.  Hi-Lo Programmer CYSTART Software (GUI)

TroubleShooting
"Error Identification on hardware !" message
■ You may see this message the first time you open Cystart. 

This means the COM port setting on Cystart does not 
match the port where the RS232 cable is connected. Click 
"OK' on the error message. Go to the Setup menu and 
select the correct COM port. The Programmer Status mes-
sage should change to EXIST.

■ The programmer is not powered. Also make sure that the 
power supplied to the programmer is 9VDC 1000mA cen-
ter negative.

■ The COM port has been assigned to another application 
by the host PC. This problem occurs when the user un-
plugs the RS232 cable from another running application 
without terminating it. Therefore, when Cystart tries to set 
up the serial communication with the programmer, the host 
PC responds with a message saying the COM port select-
ed is not available even though the RS232 cable is phys-
ically connected to the programmer.

"Error at 000000!" message.
■ The chip is incorrectly positioned on the Adapter Base's 

socket. The chip should be top justified on the socket, e.i. 
pin 1 of the chip should be placed at the top, left position 
on the socket. See Figure 1.

■ The chip is not locked on Adapter Base. Pushing the 
Adapter Base's lever forward locks the chip on the ZIP 
socket. See Figure 1.

■ The Adapter Base bottom pins have loose contact with the 
programmer socket. Make sure the Adapter Base bottom 
pins have good contact with the programmer, and the 
Adapter Base sits firmly on the programmer (the program-
mer's lever is pushed down to lock the Adapter Base in its 
position).

■ The incorrect side of the matrix card is inserted into the 
Adapter Base, or the matrix card has loose contacts with 
the Adapter Base

■ The security fuse has been blown

■ The chip is corrupted or not blank. Occasionally, the Blank 
Check feature fails. The alternative way to check the 
PROM is to do Read/Edit. If the part is blank, all bytes 
should be 0xFFs.

The part has been programmed successfully, but does not
work.
■ No .hex file was loaded onto the buffer. This results in the 

chip being programmed with 0x00.

■ The part being programmed does not match the device 
selected in the Device menu.

■ An incorrect .hex file has been programmed on the chip. 
To verify, use the Read feature to compare the checksums 
of the program on the PROM and the file on the buffer.
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Appendix A: Cypress M8 Series Programming Adapter Base and Matrix Card 
Cross-Reference

Part Number Package Programming Adapter Matrix Card

CY7C63000A-PC 20-lead PDIP Not Needed Not Needed

CY7C63000A-SC 20-lead SOIC AS-28-28-03S-6-GANG (see Note 1) Not Needed

CY7C63001A-PC 20-lead PDIP Not Needed Not Needed

CY7C63001A-SC 20-lead SOIC AS-28-28-03S-6-GANG Not Needed

CY7C63100A-SC 24-lead SOIC AS-28-28-03S-6-GANG Not Needed

CY7C63101A-QC 24-lead QSOP 130-5304-06 (see Note 2) Not Needed

CY7C63101A-SC 24-lead SOIC AS-28-28-03S-6-GANG Not Needed

CY7C63221A-PC 16-lead PDIP CY3083-DP48 CY3083-07

CY7C63231A-SC 18-lead SOIC CY3083-SC28 CY3083-07

CY7C63231A-PC 18-lead PDIP CY3083-DP48 CY3083-07

CY7C63411-PC 40-lead PDIP CY3083-DP48 CY3083-01

CY7C63411-PVC 48-lead SSOP CY3083-SS56 CY3083-01

CY7C63412-PC 40-lead PDIP CY3083-DP48 CY3083-01

CY7C63412-PVC 48-lead SSOP CY3083-SS56 CY3083-01

CY7C63413-PC 40-lead PDIP CY3083-DP48 CY3083-01

CY7C63413-PVC 48-lead SSOP CY3083-SS56 CY3083-01

CY7C63511-PVC 48-lead SSOP CY3083-SS56 CY3083-01

CY7C63512-PVC 48-lead SSOP CY3083-SS56 CY3083-01

CY7C63513-PVC 48-lead SSOP CY3083-SS56 CY3083-01

CY7C63612-SC 24-lead SOIC CY3083-SC28 CY3083-06

CY7C63613-SC 24-lead SOIC CY3083-SC28 CY3083-06

CY7C63722-PC 18-lead PDIP CY3083-DP48 CY3083-07

CY7C63722-SC 18-lead SOIC CY3083-SC28 CY3083-07

CY7C63723-PC 18-lead PDIP CY3083-DP48 CY3083-07

CY7C63723-SC 18-lead SOIC CY3083-SC28 CY3083-07

CY7C63742-PC 24-lead PDIP CY3083-DP48 CY3083-08

CY7C63742-SC 24-lead SOIC CY3083-SC28 CY3083-08

CY7C63743-PC 24-lead PDIP CY3083-DP48 CY3083-08

CY7C63743-SC 24-lead SOIC CY3083-SC28 CY3083-08

CY7C64013-PC 28-lead PDIP CY3083-DP48 CY3083-02

CY7C64013-SC 28-lead SOIC CY3083-SC28 CY3083-02

CY7C64113-PVC 48-lead SSOP CY3083-SS56 CY3083-03

CY7C65013-PVC 48-lead SSOP CY3083-SS56 CY3083-03

CY7C65113-SC 28-lead SOIC CY3083-SC28 CY3083-04

Notes 
1. 1. An SOIC-to-DIP flow-through adapter (p/n AS-28-03S-8-GANG) is available from Emulation Technologies. You can contact Emulation Technologies at 

http://www.enulation.com or by calling 1-800-ADAPTER.
2. 2. A QSOP-to-DIP flow-through adapter(p/n 130-5304-06) is available from http://www.adapters.com. You can also contact Adapters.com by calling 1-408-855-

8527. 
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Appendix A: Cypress M8 Series Programming Adapter Base and Matrix Card
Cross-Reference (continued)

In March of 2007, Cypress recataloged all of its Application Notes using a new documentation number and revision code. This new documentation number
and revision code (001-xxxxx, beginning with rev. **), located in the footer of the document, will be used in all subsequent revisions.

All product and company names mentioned in this document are the trademarks of their respective holders.

Part Number Package Programming Adapter Matrix Card

CY7C66013-PC 48-lead PDIP CY3083-DP48 CY3083-04

CY7C66013-PVC 48-lead SSOP CY3083-SS56 CY3083-04

CY7C66113-PVC 56-lead SSOP CY3083-SS56 CY3083-05
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